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ChemSep 6.2  saw  the  introduction  of  a  completely  new  pure  compound  data  manager  that  we  call  
PCDmanager – PCD is short for Pure Compound Data.

To access the databank manager open ChemSep and go to the Databanks menu. Select Pure components data 
(PCD/PCT) as shown below.

This will start the databank manager looking like this:

To view and/or edit the physical property data in an existing data file go to the  File menu and select  Open. 
Select a pcd file (the default file name that comes with ChemSep is chemsep1.pcd and will probably be visible in 
the file open selection window).
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Finding Compounds
Once a file has been loaded the left hand portion will display a list of the compounds included in the databank.  
You may scroll  up and down this list  to find compounds of interest.  You can also use the keyboard to find 
components; PCDmanager will recognize key strokes and select compounds that match the string of characters 
that have been typed. In the image below we show this portion of the screen after a successful search for  
Benzene.

The position in the list of compounds can altered using the up or down arrows. The entire record of all the data  
available in the pcd file for benzene can be erased using the  Remove button (with the red X). Note that the 
PCDmanager has a complete Undo facility and even completely deleted compound records can be recovered in 
their entirety.

The Search cell in the image below permits compounds to be found using more sophisticated criteria than their  
names (or parts thereof).

As an exercise to see what is possible trying typing the following strings into the Search cell (click on Find Next 
several times after each string):

C6 (be sure to use capital letters)

Tc=300-400

CH3CH2

403

(C)

56- (don't forget the dash)

Mw=100-200
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Pure Compound Constants
The pure compound property constants are recorded for each compound appears on a series of tab sheets in  
the right hand portion of the  PCDmanager window. These panels are displayed below for benzene. Please 
review them to learn what properties are recorded in the ChemSep pure component data files.

A complete list of property constants is provided in Appendix A.

Component Panel

The  Component panel  displays  the most  basic  information  about  the  compound,  its  name,  index  number  
(usually  this  is  the  index  number  assigned  by  DIPPR),  its  CAS  number,  SMILES  string,  structural  formula,  
molecular weight, family (from the DIPPR list) and formula. The formula is constructed from the structural  
formula and cannot be entered from the keyboard. With that sole exception all of the other entries can be  
altered simply to clicking in a cell to the right and typing a new entry. To accept a new entry press Enter or click 
in another cell.

At the foot of this tab page is a list of synonyms for the compound on display. These synonyms are from the file  
chemsep.syn that is located in the pcd subdirectory. This is a plain text file that can be edited using a text editor  
(such as Notepad, but not Word).
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Critical Properties

This panel displays some of the most important properties, namely the critical constants, normal boiling point,  
melting  point,  and  the  triple  point  temperature  and  pressure.  The  critical  constants  are  needed  in  any  
application of an equation of state to estimate thermodynamic properties. 

Note the white line near the foot of this panel that says Click here to estimate properties. As this line suggests, 
you  can  click  here  to  obtain  estimates  of  the  various  properties  that  are  listed  on  this  panel  (the  same  
opportunity  to  estimate  properties  is  available  on  several  other  panels).  This  ability  to  estimate  missing 
properties is one of the most valuable aspects of PCDmanager.
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Molecular Properties

Perhaps the most important property on this panel is the acentric factor. This property is widely used in the  
estimation of other physical properties. If the parameter is not available, it is set equal to zero.
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Equation of State Parameters

Some models make use of a special value for the acentric factor sometimes referred to as the SRK acentric  
factor. If available that value is displayed on this panel. If it is not available then  ChemSep will automatically 
assume that  the SRK acentric  factor  is  equal  to  the acentric  factor  displayed on line  2  of  the  Molecular  
Properties Panel. This panel also displays the parameters for the API version of the SRK Equation of State (if  
available). 

Finally, this panel also shows the special values of the acentric factor, solubility parameter, and liquid molar  
volume that are used in the Chao-Seader models for thermodynamic properties. In the event that the cells for  
the Chao-Seader parameter contain a * then these parameters are set equal to the values listed on lines 1, 2  
and 4 of  the  Molecular Properties Panel.
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Miscellaneous Properties

This panel displays a number of other properties that did not fit on the other panels.

The UNIQUAC parameters are needed if the UNIQUAC model is to be used to estimate activity coefficients.

The parachor is a property used in the prediction of surface tension. If not available in the databank it can 
sometimes  be  estimated  from  the  surface  tension  correlation  that  is  available  for  many  compounds  (see 
Temperature Dependant Properties). 

The Lennard-Jones parameters are available for few compounds. They are used in the estimation of transport 
properties. If unavailable, they can be estimated from critical properties.

The Rackett parameter is used in the Rackett model for liquid density.  If not available, it is set equal to the  
critical compressibility.

The COSTLD volume is used in the estimation of liquid density. If not available, it is set equal to the critical  
volume.

Log Panel

The log tab panel records changes that you make to the pcd file. The log can be saved on exit so that you can 
retain a permanent record of your changes. As an exercise click on one of the panels that display property 
constants, change one of them (any of them) and then click on the log panel to see what it displays. To return  
the data record to its original value click Ctrl-Z. Click again in the log panel to see what has changed.

As a second exercise, use the Remove button in the left-hand quarter to erase the record of a compound. Check  
to see what appears in the Log panel. Restore the compound record using Ctrl-Z.
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Temperature Dependent Properties
Many pure compound properties depend on the temperature.  PCDmanager has a special tab page for these 
properties. 

Select one of these properties to show the property constants and a table of (calculated) values of the selected 
property. The value on the Table tab that is highlighted by the blue background is at the normal boiling point. 
Select the Plot tab to display a plot instead of the table. Right click on the plot to display an overlaid menu of  
options to format the plot to your taste (as shown below). These plots can be copied into other applications 
such as word processors and spreadsheets. 

8



The Plot tab selected in the above illustration displays the selected property function graphically. The Table tab 
shows the same information in table format:

The Settings tab shown below left displays the plot title information and the axis characteristics. 

The Data tab shown below right displays the information on the Plot tab. This is the same set of numbers that 
appears on the  Table tab, but we can also see that the line settings for the plot also are displayed. We will  
return to this tab below.
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The Import tab allows PCDmanager to import data from a properly formatted text file. Click on the Open folder 
symbol on the Import tab to find the appropriate file and read the data. We see in the illustration below that  
PCDmanager can read plain text files, plot files created by ChemSep, and DIPPR text files. 

If (and only if) you have the full DIPPR source file available you may open it with this feature and import the 
actual data points contained therein. The Import tab will then display a list of the data points found (in this case 
we show the vapor pressure data for water).
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We now return to the Data tab and see this (the window has been stretched to accommodate the additional 
data).

The first two columns show the same information we saw before, the numbers having been computed from the  
correlation used to estimate, in this example, the vapor pressure of water. The additional columns (taken two at  
a time) show the experimental data that was imported from the DIPPR source file.

Returning to the Plot tab we now see the data superimpose on the correlation.
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A word of caution about temperature dependent parameters is in order. You can select the equation used to  
calculate the property as well as enter the limits. The equations available are listed below.  All temperature 
dependent  properties  require  the  temperature  in  Kelvin. Note  that  some equations  use  a  dimensionless 
temperature.

Temperature Dependent Property Correlations

Number Equation

1 Y=A
2 Y=ABT
3 Y=ABTCT 2

4 Y=ABTCT 2DT 3

5 Y=ABTCT 2DT 3ET 4

10 Y=exp A−B /TC 
11 Y=exp A
12 Y=exp ABT 
13 Y=exp ABTCT 2
14 Y=exp ABTCT 2DT 3
15 Y=exp ABTCT 2DT 3ET 4
16 Y=AexpB /TCDTET 2
17 Y=AexpBCTDT 2ET 3

45 Y=AT1
2
BT 21

3
CT 31

4
DT 41

5
ET 5

75 Y=B2CT3DT 24 ET 3

100 Y=ABTCT 2DT 3ET 4

101 Y=exp AB /TC lnTDT E

102 Y=AT B/ 1C /TD /T 2
103 Y=AB exp−C /T D
104 Y=AB/TC /T 3D /T 8E /T 9

105 Y=A/B11−T /C D

106 Y=A1−T r
BCT rDT r

2ET r
3

T r=T /T c
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107 Y=AB C /T
sinhC /T 

2

D E /T
sinhE /T 

2

114 Y=A2/B−2 AC −AD2−C23/3−C D4/2−D25/5 =1−T /T c
115 Y=exp AB /TC lnTDT 2E /T 2
116 Y=AB0.35C 2 /3DE 4 /3 =1−T /T c
117 Y=ATBC / tanh C /T DE / tanhE /T 
120 Y=A−B/TC 
121 Y=AB/TC lnTDT E

122 Y=AB/TC lnTDT 2E /T 2

207 Y=exp A−B /TC 
208 Y=10A−B/ TC 

209 Y=10A1/T−1 /B 

210 Y=10AB /TCTDT
2

211
Y=A B−TB−C 

D

A special note about the Antoine equation which has the following form:

ln P sat=A−
B

TC

satP  is the vapor pressure. ChemSep requires the temperature to be specified in Kelvin and returns the vapor 
pressure in Pascals. Parameters from other sources may need to be converted to this form of the equation 
before being entered in the databank. 
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Interface Settings can be found on the Tools menu:

The paths section at the bottom simply tells  PCDmanager where to find certain files. Normally you will not 
need to change the settings in this panel.

The data in the pcd file is recorded in SI units (with the sole exception that we use kmol rather than the more 
correct mol for molar amounts). However, data can be displayed (and entered using any convenient units. The 
units panel summarizes the set of units used for displaying each of the properties shown on the other panels. 
You  can  change the units  simply  be replacing  the  existing  unit  string  with  your  preferred alternative.  For  
example, to see the critical temperature in degrees Fahrenheit rather than the default Kelvin simply replace the  
K with an F. 
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Adding Compounds Not in the Databank
There will be many occasions when the available databanks do not contain all of the compounds needed for a  
simulation. There are several ways to add a new compound to an existing (or new) databank:

1. Direct entry of data from the keyboard

2. Importing data from the Web

3. Importing data from a PCT (Pure Compound Text) file. See, also, Appendix B.

4. Importing data from the DIPPR databank. 

Creating a New Compound Record

Click on the  Add New button (near the bottom of the central vertical row of buttons) and you will be asked if  
you wish to create a new component:

Type the name of the compound into the window that appears:

Click OK and a new record will be created for this compound: 
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Note that the name appears in the list on the left and in the topmost cell on the data panel to the right. The  
name can be changed by retyping what appears on the right.  An index number (created automatically  by 
PCDmanager) appears below the name. This too can be changed. All of the other data panels are empty; the 
various constants can simply (or not so simply) be typed in to the various cells. 

Do NOT forget to save the file once the record is complete.

Importing Component Data from a text file

PCDmanager can also export data one or more records to text files and, perhaps, more importantly, import  
pure compound data text files. This means that it is possible to add compound data from alternative sources 
using a semi-automated procedure. See Appendix B for more details.

Pure compound text (pct) files can be imported into PCDmanager from the Edit menu.

The imported text file must have the format specified in Appendices B and C.
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Importing Component Data from the Web

If, when you click on OK after typing in a compound name and your computer is connected to the Internet 
ChemSep will do two things, it will search the databank of NIST (National Institute of Science and Technology) 
for data and load what is available into a new data record.  You will also be given the option of displaying the 
NIST data page in a we browser. The images below are screen shots from the NIST page for benzene.
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One important caveat: for some compounds NIST does not use a simple polynomial  for the ideal gas heat  
capacity. In those cases, the program does not load the NIST parameters.
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Importing Data from the DIPPR Compilation

ChemSep is not supplied  with the DIPPR databank so you must have a separate license from DIPPR. If that is 
the case you can use PCDmanager to make a databank that ChemSep can read. Proceed as shown below.

1. Start PCDmanager.
2. Click on File, click on New to create a new databank.
3. Click on Edit, select Import from file

4. Click on Files of type pull down list and select DIPPR files:
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5. Search for the file source.dat in the DIPPR databank installation on your computer.

6. Click Open.
7. Answer the question posed on the window that pops up:

We recommend Automatic, otherwise you might need to accept or reject a great many compounds. If 
you follow our advice you will see this:

Importing all  compounds from DIPPR can take a while depending on the speed of  your computer,  
because there may be more than two thousand compounds in the latest DIPPR compilation.

8. When the import is complete make sure to save the file (Click on File and select Save As. We suggest 
that you save the file somewhere other than the ChemSep pcd folder and copy it to that folder for ease 
of use with ChemSep.

IMPORTANT: ChemSep rate-based simulations may need some properties that are not available in the DIPPR 
data bank. A good example is the Fuller diffusion volume (see Miscellaneous Properties tab page). PCDmanager 
contains methods to estimate many of the properties that are not included in DIPPR. We recommend that after  
importing the DIPPR databank that you review each panel to see what properties are missing and to assess 
whether or not they might be needed in your particular simulations. 

For more information please see Appendix A.
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Estimating Missing Properties

In this subsection we demonstrate how to estimate properties that might be missing from the original data  
source. 

To add the new compound click on the Add new button as shown above. Type in a name for the compound. We 
willustrate with a hypothetical compound to which we give the unimaginative name shown below:

Click OK. 

You should now see the name and an ID number that has been automatically  assigned to this  compound  
appear in the Component panel.
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We now proceed to enter a few key properties as shown in the screen images that follow.

1. The Normal Boiling Point in the Critical panel (Note: if you know the temperature in Celcius simply type 
in the value followed by a C as shown).

Press enter when complete and the value will be automatically converted to the units used for display  
purposes.

2. If  you have them available then you can enter the critical properties on the same panel. These are 
extrememly important properties and  must be recorded in the databank. We shall proceed here as 
though we do not have them available.

3. The specific gravity on the Miscellaneous panel.
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4. Return to the Critical panel and click on Estimate at the bottom of the spreadsheet. This brings up a list 
of  properties  in  this  panel  that  were  estimated  using  the  methods  built  in  to  PCDmanager.

Note that for some properties there are many different estimates available because there are many 
different methods that have been developed for estimating these properties. Select any one of these 
property estimates and click on the Apply button. Repeat as necessary to select all the properties that 
you wish estimated. 

5. Go to the  T-correlations panel  and if  not  shown,  select  the ideal  has heat  capacity.  This  is  a  very 
important property. If you have values for a correlation available then select the correlation and enter 
the values. It is very important to note that the temperature must be Kelvin and the corelation must  
provide values of the heat capacity in J/kmol. Unit conversions are not carried out for temperature 
dependent correlation constants.

If you do not have parameters for a heat capacity correlation then click on the Estimate list to see this 
(look at the lower part of the screen image below).
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Select the ideal gas heat capacity parameters, click on the  Apply   button to the right  and they wil 
appear in the upper part of the panel, along with a plot of the heat capacity.

6. Review the section below concerning Essential properties. Remember also, that some simulations may 
require  additional  properties  that  cannot  be  estimated for  hypothetical  compounds  without  some  
additional  data. For example: the Fuller diffusion volume can normally only be estimated once the 
UNIFAC structure of the molecule has been entered. If this diffusion volume is not available in the PCD  
file  then  ChemSep will  estimate it  at  run time using  an unpublished correlation developed by  the  
authors.
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Checking New Property Data

It  is useful to know that you do not need to enter values for all  of the missing properties in order to run 
ChemSep. Nevertheless, process simulation makes extensive use of thermodynamic and physical properties, 
and they can have a profound influence on the simulation results.   It is important that you assess whether or 
not the data you have saved  is adequate for your needs. 

PCDmanager incorporates a feature that allows you to check for missing data.  The check can be done on 
several different levels selected from the pull  down list on the bottom of the left side of the  PCDmanager 
window:

 
Data checking has been turned off in the illustration above.

The options available are:

• No data checking
• Check essential data
• Check preferred data
• Check reaction data
• Check all data
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If we select the second of these we will see something like this:

Notice the red X on four of the tab pages shown above, and the properties shown with their label in red (there  
are others on the other tab pages not shown in this illustration). The properties in red are those considered  
essential that are missing from this compounds data record.

Essential Properties

Index number: anything will do as long as it is between 10000 and 30000 (see note 1)
Critical temperature
Critical pressure
Critical compressibility (set to 0.25 if it is not supplied and cannot be calculated)
Critical volume (assumes /c c c cv z RT P=  if not supplied) 
Acentric factor (assumes zero if absent)
Liquid molar volume at the normal boiling point (estimated at run time if not supplied)
Molecular weight
Ideal gas heat capacity (assumes 7R/2 if not specified)

The fact  that  these properties  are  the absolute  minimum that  you need in  order  to  be able  to  do some 
equilibrium calculations should not be taken to mean that the equilibrium properties will be accurate, one must  
also ensure that the models selected for estimating properties are appropriate, and that those models do not  
need data that is not available.
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Many other properties can be estimated from just the properties listed above. Even more can be estimated if, in  
addition, the normal boiling point, specify gravity, and UNIFAC structure is provided. A list of the properties that 
are estimated in PCDmanager and/or at simulation run time is provided in Appendix A.

A special  word about the liquid molar volume at  the normal boiling point  which is  included in the list  of  
essential properties. Strictly speaking this property is not absolutely essential because many calculations can be  
done without ever needing this property and because, if it is missing a value for it will be estimated at run time  
from an unpublished correlation developed by the authors. However, the liquid molar volume is sufficiently  
important in many rate-based simulations that we have included it in the list of essential properties.

Preferred Properties

In addition to the essential properties listed above we prefer that the following also be provided:

CAS number
SMILES
Structural formula (see note 2)
Chemical formula (is determined by the program from the structural formula)
Normal boiling point
Radius of gyration
Solubility parameters
Dipole moment
Van der Waals volume
Van der Waals area
UNIFAC structure
COSTLD characteristic volume (V*)
Lennard Jones diameter
Lennard Jones energy
Rackett parameter
Fuller et al. diffusion volume 
Surface tension at normal boiling point
Parachor 
Specific gravity
Charge
SRK acentric factor
Wilson volume
UNIQUAC r
UNIQUAC q
UNIQUAC q'

We repeat the sentiments expressed above: Process simulation makes extensive use of thermodynamic and 
physical properties, and they can have a profound influence on the simulation results.   It is important that 
you assess whether or not the data you have saved  is adequate for your needs. 

We end this section with another caution: Do not make up information to enter into empty cells! For example,  
if you do not know the structural formula leave it out, do not  make up an arbitrary sequence of letters and  
numbers because it might turn out to be a legitimate chemical formula but have no relevance for the set of 
data that has been saved for this particular compound (see note 2 below).
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Notes:

1. Compound index  numbers  should  not  be duplicated!  It  is  possible,  of  course,  to  assign the same  
numbers to two different compounds in two different data banks.  No problems will arise as long as  
compounds from both databanks are never involved in the same simulation. To then use compounds 
with  the  same  index  number  from  two  different  data  banks  in  the  same  simulation  is  not  
recommended.  

2. Do NOT use PS for pseudo compounds as the program will assume P to stand for phosphorous and S to  
mean Sulfur. Pseudo compounds have their own family, called, oddly enough, Pseudo.
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Appendix A: Properties in PCD Files

The tables in this appendix summarize:

1. Properties recorded in PCDmanager
2. Properties available in the DIPPR databank
3. Properties that can be estimated by PCDmanager using just the boiling point and specific gravity
4. Properties that can be estimated by PCDmanager using the UNIFAC structure
5. Properties that are estimated at run time if they are not provided by the property databank

Properties in bold red and black are deemed essential. 
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Can be Estimated
Pure compound Constants In DIPPR in PCDmanager in PCDmanager At run time

with Tboil+SG with UNIFAC if absent
Index number √
Structural formula √
Family √
CAS Number √
SMILES string
Molecular weight √ √ √
Critical temperature √ √ √
Critical pressure √ √ √
Critical volume √ √ √ √
Critical compressibility factor √ √ √ √
Normal boiling point √ √
Melting point √ √
Triple point temperature √
Triple point pressure √
Liquid molar volume at normal boiling point √ √
Acentric factor √ √ √
Radius of gyration √ √
Solubility parameter √ √
Dipole moment √
Van der Waals volume √ √
Van der Waals area √ √
IG heat of formation √ √
IG Gibbs energy of formation √ √
IG absolute entropy √
Heat of fusion at melting point √ √
Standard net heat of combustion √ √



The table below lists some additional pure compound constants that are not available in DIPPR. Some of these  
properties  are  estimated  automatically  by  PCDmanager when  the  DIPPR  source  file  is  imported.  These 
properties are identified by the * in column 2 of the table below. 

The methodology used to assign these property values is summarized below.

1. The COSTALD characteristic volume is estimated from a published correlation. If not applicable it is set  
equal to the critical volume.

2. The Fuller diffusion volume is estimated from an unpublished correlation developed by the authors of  
ChemSep.

3. The SRK acentric factor is set equal to the standard acentric factor.
4. The Wilson volume is set equal to the molar volume at the normal boiling point.
5. The Chao-Seader acentric factor is set equal to the standard acentric factor.
6. The Chao-Seader solubility parameter is set equal to the standard solubility parameter.
7. The Chao-Seader volume is set equal to the molar volume at the normal boiling point.
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Can be Estimated
Pure compound Constants In DIPPR At run time

with other if absent
COSTLD characteristic volume (V*) * √

√ √
√ √

√
* √ √

Surface tension at normal boiling point √ √
√ √

Specific gravity √
Charge

* √
Wilson volume * √ √
UNIQUAC r √ √
UNIQUAC q √ √
UNIQUAC q' √
API SRK s1 √
API SRK s2 √

* √
* √
* √

in PCDmanager in PCDmanager
with Tboil+SG

Lennard Jones diameter
Lennard Jones energy
Rackett parameter
Fuller et al. diffusion volume

Parachor

SRK acentric factor

Chao-Seader acentric factor
Chao-Seader solubility parameter 
Chao-Seader liquid volume



The table below summarizes the temperature dependent properties that can be recorded in PCDmanager and 
those that are available in DIPPR. Note that only the ideal gas heat capacity (one of the essential properties)  
and the Antoine vapor pressure can be estimated with just the normal boiling point and specific gravity. Some  
additional properties can be estimated if more information is available (critical properties, normal boiling point  
etc.). Note that  ChemSep contains methods to predict all of these properties at run time if they are needed 
during a simulation so it is not essential that any of these properties be estimated in PCDmanager other than 
the ideal gas heat capacity). 
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Can be Estimated
Temperature Dependent Properties In DIPPR in PCDmanager in PCDmanager At run time

with Tboil+SG with other if absent
Solid density √
Liquid density √
Vapour pressure √
Heat of vaporization √ √
Solid heat capacity √
Liquid heat capacity √
Ideal gas heat capacity √ √ √ √
Second virial coefficient √
Liquid viscosity √
Vapour viscosity √
Liquid thermal conductivity √ √
Vapour thermal conductivity √ √
Surface tension √ √
Relative static pemittivity
Antoine vapor pressure √



Appendix B: Pure Compound Data Text Files

PCDmanager can export property data to text files. An advantage of text files is that they can be read (or 
created) by many different programs. PCDmanager can also import property data from a file with the correct 
format. 

The first step is to create a template PCT file that can be edited and then imported back into PCDmanager. A 
clean template can be created as follows:

1. Start PCDmanager (or click on File, New)
2. Click the Add New button
3. Type something in the window that appears
4. Click OK
5. Select the new “compound” in the list on the left
6. Click on Edit, Export to File
7. Make sure that the file type is pct
8. Give the file a name and save the file somewhere that you can find it.

You have now created an empty template file that can be loaded into a text editor. The content of the text file is 
shown as columns 2 and 3 of  the table in Appendix C (note that the spacing differs in the actual text file from 
that shown in the table).

To create a new pure compound record enter as much data as you can into the text file y replacing the * and 0 
where appropriate. Essential properties are shown in red, desirable properties in bold face (consult the section 
above on Essential Properties). All other properties can be omitted if data is not available, but it is advisable to 
leave unknown parameters as *; do not replace them with a 0 – zero – as this can have serious negative 
consequences. 

Alternatively, you can copy the data into a spreadsheet (in fact a spreadsheet was used to create the table in 
Appendix C). This spreadsheet template is available from the authors.

If you prefer to use the spreadsheet template fill in the data in Column 2 only (again, refer to the essential 
properties section as needed). Once completed (to the extent possible) proceed as follows (and repeat as 
needed for each new compound).

1. Copy 192 lines of column B starting from [Compound Data] (line 1) and ending with a blank line (line 192) 
beginning to a text editor (not Wordpad or Word) 

2. Save text file with extension .pct. For example: pseduo01.pct
3. Go to Edit menu in PCDmanager
4. Select Import from file
5. Select pct file created in Steps 1 and 2
6. Select Confirm Each (do NOT select automatic)
7. Import compound
8. Click on Stop button
9. Go to File menu
10. Select Save (if adding to an existing file) or Save as (for a new databank)
11. Save as a pcd file 
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Appendix C: Pure Compound Data Text File Template
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Line Template Content of cell to the left Units Example
1 [Component Text] Mandatory header [Component Text]
2 *             Index 501
3 Benzene
4 Structural formula CHCHCHCHCHCH-
5 0 Family 51
6 *             Critical temperature K 5.62050E+02
7 *             Critical pressure Pa 4.89500E+06
8 *             Critical volume 2.56000E-01
9 *             Critical compressibility factor Ä 2.68000E-01
10 *             Normal boiling point K 3.53240E+02
11 *             Melting point K 2.78680E+02
12 *             Triple point temperature Pa 2.78680E+02
13 *             Triple point pressure 4.76422E+03
14 *             Molecular weight 7.81140E+01
15 *             Liquid molar volume at normal boiling point 8.94100E-02
16 *             2.09000E-01
17 *             Radius of gyration m 3.00400E-10
18 *             Solubility parameter 1.87000E+04
19 *             Dipole moment 0.00000E+00
20 *             4.84000E-02
21 *             6.00000E+08
22 *             IG heat of formation 8.28800E+07
23 *             IG Gibbs energy of formation 1.29600E+08
24 *             IG absolute entropy 2.69300E+05
25 *             Heat of fusion at melting point 9.86600E+06
26 *             Empty *            
27 *             Standard net heat of combustion -3.13600E+09

CompoundName

m3/kmol

kg/mol

m3/kmol
Acentric factor

sqrt(J/m3)
Coulomb.m

Van der Waals volume m3/kmol
Van der Waals area m2/kmol

J/kmol
J/kmol/K
J/kmol/K
J/kmol

J/kmol
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Line Template Content of cell to the left Units Example
28 0 EqNo of T correlation  Solid density kmol/m3 2
29 *             A 1.30590E+01
30 *             B -3.48380E-04
31 *             C *            
32 *             D *            
33 *             E *            
34 *             Min.Temp. K 2.73100E+02
35 *             Max.Temp. K 2.82600E+02
36 0 EqNo of T correlation  Liquid density kmol/m3 105
37 *             A 9.99380E-01
38 *             B 2.63480E-01
39 *             C 5.62050E+02
40 *             D 2.78560E-01
41 *             E *            
42 *             Min.Temp. K 2.73100E+02
43 *             Max.Temp. K 5.62050E+02
44 0 EqNo of T correlation  Vapour pressure Pa 101
45 *             A 8.83680E+01
46 *             B -6.71290E+03
47 *             C -1.00220E+01
48 *             D 7.69400E-06
49 *             E 2.00000E+00
50 *             Min.Temp. K 2.72040E+02
51 *             Max.Temp. K 5.62160E+02
52 0 EqNo of T correlation  Heat of vaporization J/kmol 106
53 *             A 4.88100E+07
54 *             B 6.10660E-01
55 *             C -2.58820E-01
56 *             D 3.22380E-02
57 *             E 2.24750E-02
58 *             Min.Temp. K 2.73100E+02
59 *             Max.Temp. K 5.62050E+02
60 0 EqNo of T correlation  Solid heat capacity J/kmol/K 100
61 *             A -1.24610E+02
62 *             B 9.09020E+02
63 *             C -6.04900E+00
64 *             D 2.28850E-02
65 *             E -2.46380E-05
66 *             Min.Temp. K 4.00000E+01
67 *             Max.Temp. K 2.78700E+02
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Line Template Content of cell to the left Units Example
68 0 EqNo of T correlation  Liquid heat capacity J/kmol/K 16
69 *             A 1.11460E+05
70 *             B -1.85430E+03
71 *             C 2.23990E+01
72 *             D -2.89360E-02
73 *             E 2.89910E-05
74 *             Min.Temp. K 2.78680E+02
75 *             Max.Temp. K 5.00000E+02
76 0 EqNo of T correlation  Ideal gas heat capacity J/kmol/K 16
77 *             A 3.53450E+04
78 *             B -6.05220E+02
79 *             C 1.28470E+01
80 *             D -2.10290E-04
81 *             E 4.88000E-08
82 *             Min.Temp. K 2.00000E+02
83 *             Max.Temp. K 1.50000E+03
84 0 EqNo of T correlation  Second virial coefficient m3/kmol 104
85 *             A 1.75070E-01
86 *             B -2.20130E+02
87 *             C -1.80850E+01
88 *             D -7.40460E+03
89 *             E 1.66900E+04
90 *             Min.Temp. K 2.81020E+02
91 *             Max.Temp. K 1.96700E+03
92 0 EqNo of T correlation  Liquid viscosity Pa s 101
93 *             A -2.46100E+01
94 *             B 1.57650E+03
95 *             C 2.16980E+00
96 *             D -5.13660E-06
97 *             E 2.00000E+00
98 *             Min.Temp. K 2.78680E+02
99 *             Max.Temp. K 5.45000E+02
100 0 EqNo of T correlation  Vapour viscosity Pa s 102
101 *             A 3.13660E-08
102 *             B 9.67500E-01
103 *             C 8.02850E+00
104 *             D -3.56290E+01
105 *             E *            
106 *             Min.Temp. K 2.73100E+02
107 *             Max.Temp. K 1.00000E+03
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Line Template Content of cell to the left Units Example
108 0 W/m K 16
109 *             A 4.95390E-02
110 *             B -1.77970E+02
111 *             C 1.94750E-01
112 *             D -7.38050E-03
113 *             E 2.79380E-06
114 *             K 2.73100E+02
115 *             K 4.13100E+02
116 0 W/m K 102
117 *             A 4.95490E-06
118 *             B 1.45190E+00
119 *             C 1.54140E+02
120 *             D 2.62020E+04
121 *             E *            
122 *             K 2.50000E+02
123 *             K 1.00000E+03
124 0 N/m 16
125 *             A -2.57500E-02
126 *             B -2.12190E+02
127 *             C -6.20890E-01
128 *             D -5.97380E-03
129 *             E 2.17710E-06
130 *             K 2.73100E+02
131 *             K 5.62050E+02
132 0 100
133 *             A 2.95250E+04
134 *             B -5.14170E+01
135 *             C 1.19440E+00
136 *             D -1.64680E-03
137 *             E 6.84610E-07
138 *             K 5.00000E+01
139 *             K 1.00000E+03
140 0 0
141 *             A *            
142 *             B *            
143 *             C *            
144 *             D *            
145 *             E *            
146 *             K *            
147 *             K *            

EqNo of T correlation  Liquid thermal conductivity

Min.Temp.
Max.Temp.
EqNo of T correlation  Vapour thermal conductivity

Min.Temp.
Max.Temp.
EqNo of T correlation  Surface tension

Min.Temp.
Max.Temp.
EqNo of T correlation  Ideal gas heat capacity (PGL) J/kmol/K

Min.Temp.
Max.Temp.
EqNo of T correlation  Relative permittivity

Min.Temp.
Max.Temp.
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Template Content of cell to the left Units Example
0 Pa 10
*             A 2.10750E+01
*             B 2.97730E+03
*             C -4.15050E+01
*             D *            
*             E *            
*             K 3.38000E+02
*             K 5.05400E+02
0 Pa s 13
*             A -2.71900E+00
*             B -1.97340E-02
*             C 1.32630E-05
*             D *
*             E *            
*             K 2.78680E+02
*             K 5.45000E+02
*             COSTLD characteristic volume (V*) 2.56390E-01
*             m 5.75303E-10
*             K 3.20607E+02
*             2.69600E-01
*             cm3 9.09600E+01
*             Surface tension at normal boiling point N/m 2.11083E-02
*             3.67000E-02
*             Specific gravity 8.82619E-01
*             Charge *            
*             2.13670E-01
*             Wilson volume 8.94100E-02
*             UNIQUAC r 3.18780E+00
*             UNIQUAC q 2.40000E+00
*             UNIQUAC q' 2.40000E+00
*             API-SRK s1 *            
*             API-SRK s2 -3.18000E-04
*             Empty 2 *            
*             2.13000E-01
*             1.87368E+04
*             8.94000E-02
0 0 0 0 0 0 0 0 0 0 0 0 UNIFAC 10 6 0 0 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 0 0 0 UNIFAC-LLE 10 6 0 0 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 0 0 0 ASOG 0 0 0 0 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 0 0 0 GC EOS 10 6 0 0 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 0 0 0 UMR 10 6 0 0 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 0 0 0 Modified UNIFAC 10 6 0 0 0 0 0 0 0 0 0 0

CAS Number 1-43-2
SMILES string 1ccccc1
Empty line - must be present

EqNo of T correlation  Antoine (Pa)

Min.Temp.
Max.Temp.
EqNo of T correlation  Liquid viscosity (PGL)

Min.Temp.
Max.Temp.

m3/kmol
Lennard Jones diameter
Lennard Jones energy
Rackett parameter
Fuller et al. diffusion volume

Parachor (kg¬.m3/s«/k)

SRK acentric factor
m3/kmol

Chao-Seader acentric factor
Chao-Seader solubility parameter sqrt(J/m3)
Chao-Seader liquid volume m3/kmol
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